
Section 6: Independent Production of E-text 

SECTION 6 
INDEPENDENT PRODUCTION OF E-TEXT  

USING KURZWEIL 1000 
(WHAT IT IS AND SUGGESTIONS FOR IMPLEMENTATION) 

Introduction 

The module Independent Production of E-text will address the use of the Kurzweil 1000 
program to provide independent access to print. Access can be obtained through the 
use of a scanner or through the importation and recognition of non-editable graphics files 
which contain text. This module will outline the procedure for acquiring and recognizing 
text and it will provide tips and strategies for efficient and successful implementation. 

Description of Student Need 

Students need to access all printed curricular resources that are used in the classroom. 
This includes both textbooks and Teacher prepared materials.  They also need access 
to research materials, both hard copy and online source material.  Beyond that, students 
need an efficient method of organizing, skimming and summarizing these materials. 
Kurzweil 1000 provides solutions for all of these student needs.  Using Kurzweil 1000 
students can access these resources and features in e-text which can then be read in 
hard copy Braille and/or refreshable Braille. 

Assumptions 

• The student creating e-text independently understands what Kurzweil 1000 can do 
and why it would be useful. Furthermore, they have a need and desire to produce e-
text independently. 

• Materials in hard copy will require that the student has an organized way of filing and 
retrieving paper Braille.   

• The student will benefit from the active process of reading, (rather than the passive 
process of listening), therefore the student who utilizes e-text should, whenever 
possible, do so via hard copy (translated) Braille or a refreshable Braille display.  

Prerequisites 

• Students have a working knowledge of the Windows file structure and hierarchy as 
presented in Windows Explorer. 

• Students have a working knowledge of Windows menu and sub-menu structures and 
conventions. 

• Students have a working knowledge of Windows cursor movement commands. 
• Students have a working knowledge of common word processing features 

(specifically, the use of a spellchecker, Find, Replace and Go To commands). 
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Team support needed to setup and implement the independent 
production of e-text 

The student will require sequential instruction in the use of the Kurzweil 1000 program. 
This instruction will start with basic scanning and/or text importation and associated 
reading commands. It will progress through its many features and end with the ability to 
use Kurzweil 1000 as a tool for study skills. 

Classroom Implementation Strategies 

The Kurzweil 1000 program is designed for use outside the classroom. It’s main purpose 
will be to allow the student independent access to print in order to prepare for classroom 
activities and assignments. It will also allow the student to access and organize research 
materials, so that they may be saved and reviewed in an efficient manner. 

Common Barriers or challenges that might occur 

The student will require time to learn the Kurzweil 1000 program in advance of needing it 
to access print materials. The student will also need to be able to get the print materials 
(or existing e-text materials) in order to have source materials to work with.  This may 
involve learning library systems and the ability to do efficient searches for appropriate 
print (or online) materials. 

Equipment Needed 

• Current Pentium computer (256 meg RAM, Windows 98 or higher)  
• Software designed to provide independent access to print materials (i.e. Kurzweil 

1000) 
• Supported scanner (e.g. Epson). Check Kurzweil 1000 website before purchasing 

(www.kurzweiledu.com)  
• Industry standard word processor (e.g. Microsoft Word 2000 or 2002 
• (Optional) Braille Embosser 
• (Optional) Refreshable Braille Display 

FAQ 

1. Kurzweil 1000 appears to only provide speech output. The student prefers 
refreshable Braille. How can I use refreshable Braille with Kurzweil 1000? 

There are two ways you can use refreshable Braille with Kurzweil 1000.  The first 
us by saving your file in one of Kurzweil’s pre-defined Braille notetaker formats 
and then transferring the file to it.  The other is to use it with JAWS and a 
dedicated Braille display.  

When Kurzweil 1000 is opened JAWS goes to sleep, however, its Braille display 
drivers keep working. The display will track the document that is open in Kurzweil 
1000 
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2. Do I need a word processor if I have Kurzweil 1000? 

Kurzweil 1000 has many word processor features and all Kurweil 1000 files are 
text based so they are fully editable. However, a word processor is still 
recommended for its advance formatting features.  

3. Should I use Kurzweil 1000 to provide e-text for the student instead of OmniPage 
Pro? 

There are good reasons to use Kurzweil 1000 as your main OCR program when 
supporting students.  The main ones are: 

a) The choice of 2 recognition engines gives flexibility for speed and accuracy 
needs. 

b) Scan optimization tailors the scanning settings to the individual document to 
ensure the best recognition results. 

c) The low vision student can use image files for on-the-fly magnification 
combined with speech output. 

d) Outlines can quickly be created for the student prior to their reading large 
documents. This gives the student a synopsis of what the source material will 
be about. 

The main drawback to using Kurzweil 1000 for both Braillist and student use is its 
very high price (currently $1595.00). 

Information and Instructions for Kurzweil 1000 
 
Using Kurzweil 1000 for the Independent Production of E-text 

Introduction 

Kurzweil 1000 is a program that allows the blind user to have independent access to: 

• Printed material in books, magazines, newspapers and any other paper publication 
and/or format through the use of a scanner 

• Non-editable text found on computers such as graphic text found on many web 
pages and graphic file formats such as Adobe Acrobat files (.pdf) 

• Any text based file which can be imported for use with the specialized Kurzweil 1000 
features 

All Kurzweil 1000 files are fully, editable text-based documents so information can be 
added to any document, bookmark or summary. 

Kurzweil 1000 is not a screen reader. It does not read the contents of other applications. 
It uses OCR (optical character recognition) technology to create a version of the page 
that it can read aloud. It does not replace a full word processor. 
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Within Kurzweil 1000 the user has access to a variety of settings which allows 
customization of: 

• Voices – there are different voices for text (reading voice) and headings (system 
voice). Voice, pitch and speed can also be adjusted 

• Scanning – there are settings to maximize scans according to the quality of the 
original 

• Recognition – there are settings to identify columns, text colour and quality, as well 
as selecting from two recognition engines 

• Reading – there are different reading units available as well as the ability to advance 
and rewind reading. Punctuation, header omission , and many other reading options 
are available 
 
(Note: this is not a complete list of settings) 

Kurzweil 1000 has a built in dictionary and thesaurus. Words within its dictionary 
definitions and thesaurus choices can also looked up for further explanations. 

Kurzweil 1000 also allows the user to condense large text articles through its browsing, 
summarizing and book marking features. This gives the blind user an efficient ability to 
scan through documents looking for appropriate information. It also useful for creating 
study outlines and guides. 

Kurzweil 1000 can be set to keep image files (the scanned graphics files that were used 
for recognition). This is useful because if the page was poorly recognized the user can 
change the recognition settings and then re-recognize the page (without having to re-
scan the page). 

Kurzweil 1000 can be used to recognize currency. This feature is beyond the scope of 
this document. See the Online Manual for instructions on recognizing currency. 

Kurzweil 1000 can create mp3 files which can be transferred to audio devices for mobile 
access. This feature is beyond the scope of this document (which deals only with the 
creation and use of e-text). See the Online Manual for the creation of mp3 files). 

Kurzweil 1000 can interface with Braille note takers for portable access. 

Using Kurzweil 1000 you can search and retrieve electronic books from three web sites 
(Baen.org, Bookshare.org and Project Gutenberg). This feature is beyond the scope of 
this document. See the Online Manual for instructions on accessing online electronic 
texts.  

How to get E-text into Kurzweil 1000 

1. Text may be transferred into Kurzweil 1000 through the use of a scanner. The 
process is as simple as putting the print document face down on the scanner and 
pressing the scan command (F9). By default Kurzweil 1000 scans, reports on the 
scanning process and then begins reading the document. If the page is put in 
sideways or upside down the orientation is automatically corrected for reading. If it is 
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put in face up Kurzweil 1000 reports a blank page. See section “Using Kurzweil 1000 
with a Scanner” for more detail. 

 
2. Text may be imported from any text-based file (Word, Excel, Word Perfect, RTF, text 

file). There are advantages to importing text into Kurzweil 1000 rather than reading in 
the word processor using a screen reading program. They are: 

o Text in Kurzweil can be structured using multi-leveled bookmarks (see the 
section “About Bookmarks”). There are six levels of bookmarks that can be 
created. Bookmarking allows the user to create outlines and get a synopsis of the 
material before reading it for content. Descriptions may be added to each 
bookmark to provide a user defined summary 

o Text may be browsed. That means only the first and/or the last sentence of each 
paragraph will be read. This provides a quick way of skimming through a 
document 

o Text may be summarized. That means its content will be reduced to 10% of the 
original and extracted to a new file (with “summary” added to the file name. You 
can also create a summary document from the bookmarks.  

3. An image file can be transferred into Kurzweil 1000 using the virtual printer (KESI 
Printer that is put into the printer list on). Using this method, files which otherwise 
would not be readable will be recognized and converted into editable text. This is 
useful for: 

o Adobe Acrobat file (.pdf) which otherwise would be detected by the screen 
reader as a graphic and not read 

o Some websites that have text which is really a graphic and not readable using a 
screen reading program 

o Sometimes pages scanned by typical OCR programs will incorporate any text 
which describes or explains a picture, into the picture. When this occurs the 
screen reader will detect it all as graphic, and not read the text that describes the 
picture. Printing it to Kurzweil 1000 may allow you to read the text associated 
with the picture (see the section “More About Image Files” 

Reading and Processing Commands 

Kurzweil 1000 has two ways of executing reading and processing commands. They are: 

1. Using the Numeric keypad. All keys on the keypad have commands assigned within 
Kurzweil 1000. In fact there are three layers of commands. By default the keypad is 
set to the “reading keypad”. Using this layer you press keys to (among other things): 
start and stop scanning; start and stop reading; adjust the volume; adjust the reading 
speed; fast forward and rewind by the reading unit (sentence, line, or paragraph); as 
well as access the dictionary, spellchecker, and online help. The second layer is the 
“file management keypad”. It is accessed by holding down the Shift key and tapping 
Accept key (top right on keypad) until you hear the layer that you want. The “file 
management keypad” allows changes the functionality of the keys to create and 
delete folders, move between folders as well as open, close, delete, and save 
document files. The third layer is the “settings keypad”.  When this keypad layer is 
chosen the keys will let you customize reading and system voices and change some 
scanner settings. Each layer has further options when the Shift key is held down 
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before pressing the buttons on the respective keypad layer. Refer to the manual for 
all keypad assignments for each layer. 
 

2. Using a combination of the Function keys across the top of the keyboard and either 
Shifted Function keys or Control keys (Control + a letter), all reading and processing 
commands can be executed. The basic keys for reading and processing are: F5 
(toggle between continuous reading and stop); F6 (read previous unit); F7 (read 
current unit); F8 (read next unit); F9 (scan page); F11 (slow down reading speed); 
F12 (increase reading speed). Other Function key assignments are: F1 (context 
sensitive Help); F2 (general Help); F3 (Find Next); F4 (Close Document); F10 
(transfers the focus to the menu bar). 

3. Hotkeys for executing commands can be found in the menus beside each item. 

Working with Text in Kurzweil 1000 

• Using Kurzweil you can read by line, sentence or paragraph. To change the reading 
unit open the Settings menu and choose Reading… (as a Windows convention any 
item ending with an ellipsis will open a dialogue box). The Reading dialogue box has 
settings to change the reading unit (see the section on “The Settings Dialogue Box” 
for all of the reading options).  You can also use standard Windows cursor 
movement commands to have text read (see Appendix A for Windows Reading 
Commands). 

• Words can be spelled by pressing Control+L when the cursor is on the word. 

• The Page Up and Page Down keys function differently in Kurzweil 1000. Pressing 
these keys moves the document by physical pages rather than by screens of 
information. That does not mean that all information on the physical page is 
displayed. You may have to arrow down to get to the bottom of the page. Pressing 
Page Up or Page Down moves you to the top of that page (i.e. previous page or next 
page). 

• Using the Go To command (Control+G) you can jump to any page in the document. 
This is fine as long as you started scanning at page 1. If you did not begin scanning 
at page 1 Kurzweil 1000 will assign the first scanned page as page 1 (even though it 
may be page 63 in the book it came from). To adjust Kurzweil 1000 to match the 
page numbers in the hard copy book you must “set page numbers”. To do this open 
the Edit menu and choose “Set Page Number”.  Type the page number that 
corresponds with the page number in the book and press Enter. This synchronizes 
Kurzweil 1000’s page reporting with that of the hard copy book. Numbers will 
continue consecutively until you set a new page number (which you would do if 
pages such as the beginning of a chapter were unnumbered in the print book, or, you 
left out a section and then continued scanning again). The Go To command now 
takes you to the pages that correspond to the source material. 

• Kurzweil 1000 uses two different voices. One, the Reading Voice is used for regular 
text. The other, the System (or Message) Voice, is used for text that is bold, 
italicized, or underlined. This can be useful in helping to understand the structure of 
the document and for setting bookmarks (although level one bookmarks should be 
created from the Table of Contents (see the section “Using Kurzweil 1000  as a 
Study Tool”). 
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• When reading through a document you can access the dictionary at any time. To do 
this put your cursor on a word and press Control+D (or access the dictionary from 
the Read menu. Kurzweil 1000 will say, “The word to be defined is …..”  Press Enter 
to hear the definition. There may be many definitions. Press Enter again (or Alt+N) to 
hear the next definition(s). Press Alt+P to go back and hear previous definitions. 

• When reading through a document you can access the Thesaurus at any time.  To 
do this put your cursor on a word and press Shift+F7 (or access the Thesaurus from 
the Read menu).  Kurzweil 1000 will say, “Synonyms will be found for …..”  Press 
Enter again to hear the first synonym for the word. Press Enter (or Alt+N) again to 
hear the next synonym(s). Press Alt+P to hear previous synonyms. If you want one 
of the synonyms defined you can press Control+D and you will switch into the 
Dictionary and the word will be defined. Note that by doing this you have left the 
Thesaurus. To return to it you must exit the Dictionary (press Escape) and re-enter 
the Thesaurus by pressing Shift+F7 again. 

Getting Help in Kurzweil 1000 

• Pressing F1 provides context sensitive help wherever you are in Kurzweil 1000. This 
includes all of the controls in a dialogue box 

• Pressing F2 provides general help about the kind of environment you are in (e.g. 
general information about what a dialogue box is). This help is not always available 
(e.g. on a menu item) 

• Using the Help menu you can: 

1. Get information about the Reading Status. This gives all of the current 
reading settings 

2. Get information about the Settings Status. This gives information about a 
wide variety of current scanner and process settings 

3. Open the Manual.  The Kurzweil 1000 Online Manual is a searchable, text 
based document. Information may be obtained from the Manual in 2 ways. 
The first is by using Kurzweil 1000’s bookmarking features (see the section 
“About Bookmarks”). The Manual has been pre-bookmarked so pressing 
Control+R (or access bookmarks from the Read menu) will bring up a 
dialogue box of chapter bookmarks. Each chapter bookmark is broken down 
into sub-heading bookmarks to access specific features within each chapter 
(see the section “Creating and Using Bookmarks”). The second way to use 
the Online Manual is to search it by keywords. This is useful if you wish to 
follow a keyword throughout the manual. To search the Online Manual press 
Control+F (or access Find through the Edit menu). To find the next 
occurrence of the keyword press F3. Note that the Online Manual remembers 
where you were last and opens to that place. Searching a new keyword will 
begin from there unless you move to the beginning of the Online Manual 
when you begin a new search using the Find command. 

Note that this Find command is not restricted to the online manual. It 
can be used in any scanned or imported document. 
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Using Kurzweil 1000 with a Scanner 

Kurzweil 1000 is an OCR program that is specifically designed to simplify the scanning 
and reading process for users who are blind. Using the scan (F9) and read keys (F5, F6, 
F7, and F8) users can instantly create and read e-text. As you become more familiar 
with the program you will find that it contains many intermediate and advanced features 
to control the scanning process and improve its efficiency. By default, Kurzweil 1000 
scans, recognizes the text and then automatically begins reading it to you.  

As previously stated Kurzweil 1000 automatically corrects the page orientation. Reading 
in Kurzweil 1000 is a separate process from scanning so you can stop the reading (F5 or 
Control key) and continue scanning (F9) if you have many pages to do. It is also 
possible to scan one document while reading another. Kurzweil 1000 can keep track of 
two documents at the same time and differentiates between the scanning and the 
reading document (if they are different). It will append a new scan to the scanning 
document even though you may be reading another document. 

• Scanned pages are, by default, placed at the end of the document that you are 
scanning. If you want them placed in front of the current scanned page open the 
Scan menu and choose “Insert Page”.  

• If you want to scan two pages at a time (such as with a paperback novel) open the 
Settings menu and choose Recognition. In this dialogue box change the Two Page 
listbox to show “Two Pages” (it is set to “One Page” by default). 

• You can have Kurzweil 1000 scan automatically without pressing the scan key (F9). 
To do this, set the time between scans in the Settings menu (choose Scan). Then 
press Shift+F9 and scans will occur automatically with whatever delay that you set 
between scans. To cancel the automatic scanning process press F9 (or choose 
“Cancel Scan” from the Scan menu). 

• You can also have Kurzweil 1000 just scan pages and have them recognized later. 
However, if you are using a current computer system, this is unnecessary as the 
page will typically be recognized before you can put a new page on the scanner so 
there is no savings in efficiency or time. For information on how to do this please 
refer to the Program Manual. 

• Scanner settings can be adjusted to optimize the results for reading accuracy. These 
settings are made in the Settings menu under Scanning. The main setting that can 
be adjusted are: (see section Tips for Scanning in the Online Manual for more detail). 

1. Thresholding – the way the pixels on the page (the tiny dots that make up the 
characters) are interpreted for recognition. The choices are static, dynamic, 
grayscale, and colour.  Static is the default 

2. Brightness – the darkness or lightness of the overall image before recognition 
is determined on a scale of 1 to 100. The default is 50 

3. Resolution – This is related to font size and the ability to make it legible in the 
image file. The default resolution is 300 dpi (dots per inch). Raising the 
number will increase legibility for poorly recognized letters, but it will slow 
down the scanning process 

• Kurzweil 1000 has an option in the Scan menu to “Optimize Scanning…”  Choosing 
this brings up a dialogue box where you can have the program determine the best 
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settings for you by choosing to have all or any of them optimized. Kurzweil 1000 will 
make repeated scans over the page to determine the best settings. This is especially 
useful before you start a long scanning job where the pages are consistent in their 
quality. It will ensure that you have the best settings before you start. 

About the Recognition Process 

Creating readable text is the product of two processes. The first is the scanning process 
which was described above. This process creates an image file for each page of the 
source material. This image file is graphical and non-editable. By default the image file is 
discarded when the recognition process is completed. There are many good reasons to 
keep image files as will be discussed later. The second process is recognition. This 
process turns the image file into readable, editable text. Recognition results determine 
the quality of the final document. 

• Kurzweil 1000 has two recognition engines to choose from. The first one (the default) 
is the RTK engine. It is faster than but not as accurate as the other one (FineEngine). 
RTK supports many languages and works best for numbers. The other recognition 
engine is FineEngine. It is somewhat slower the RTK engine but is considerably 
more accurate. It also supports many languages. FineEngine supports grayscale 
scanning while RTK does not.  If recognition is poor, consider changing the 
recognition engine to FineEngine first. To do this open the Settings menu and 
choose Recognition. Change the recognition engine in the Engine listbox. 

• Re-recognition may be necessary if the results were poor. It is usually more 
convenient to re-recognize a page than it is to re-scan it.  To re-recognize a page 
open the Scan menu and choose Re-recognize Page. There are many settings to 
improve recognition, but first the image file must be kept (remember that it is 
discarded by default). To keep the image, open the Settings menu and choose 
General. Change the Keep Images listbox to “Enabled”. Now pages will be available 
for re-recognition. The main changes that can be made to improve accuracy during 
re-recognition are found in the Settings menu under Recognition. These changes 
are: 

1. Change the recognition engine to FineEngine. Some users keep this as the 
default because of its superior recognition ability. 

2. Identify columns – it is best to keep this enabled in case there are columns on 
the page. 

3. White on Black – it is best to keep this enabled in case there is inverted text on 
the page. 

4. Speckle Removal – This filter looks for small, stray, or random dots on the page 
and eliminates them from the image. Use with caution, though, as the speckle 
removal filter may impair recognition of very small text. It also adds slightly to the 
recognition time. 

5. Text Quality – It defaults to “normal”. Use “degraded” only if the text quality is 
very poor as it can impair the recognition quality of normal text. Use Draft Quality 
for dot matrix printers. 

6. Partial Columns – This setting has two values, Kept and Ignored. Kept is the 
default. Ignore means that text (less than 2 inches wide) which overlaps the 
scanner glass (e.g. from the second page of an opened book) will be ignored. 
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However, it will also ignore narrow columns on a single page that are positioned 
close to the edge. It is only useful if you know you are scanning something that is 
wider than the scanner. 

Using the Recognition Statistics to Improve Scanning 

Kurzweil 1000 tracks and provides the recognition statistics for the last page scanned as 
well as all pages scanned. (All pages is cumulative in that it includes all of the 
documents ever scanned using Kurzweil 1000, however, it can be reset to zero.) 

Kurzweil also tracks poorly scanned pages. To access this information open the Tools 
menu and choose Recognition Statistics. This lets you review a breakdown of important 
aspects of the recognized image. The recognition statistics provide valuable information 
on the accuracy of the scan and by doing so provides information on how to improve it 
during re-recognition. Specifically it tracks:  

• The speed of the scan. This is the amount of time it took Kurzweil 1000 to convert 
the page image into characters. The higher the number the easier it was to convert, 
therefore, the better the recognition accuracy.  

• The confidence level of the recognized image. The confidence level is a threshold 
measured in a percentage. There is a confidence level for every page image. The 
confidence level takes into account the number of characters scanned, the number 
of illegible characters, and the number of questionable characters. The higher the 
percentage the more confident Kurzweil 1000 is regarding the accuracy of the 
recognition process for each page image. This useful for many reasons. They are: 

1. It tells you right away whether or not you need to make scanner or recognition 
adjustments before proceeding. Typically a confidence level below 90% means 
there were many errors in recognition. Ideally you want a confidence level above 
96%, but anything above 90% should be quite readable. Note that the confidence 
level is a statistically manufactured number, so its reliability will vary. It reflects 
letter recognition accuracy, best on pages that are pure text, with no diagrams or 
stray lines to confuse it. 

 
2. You can manually set the confidence level for “poorly scanned pages”. Those 

images will then be kept for re-recognition. To set the confidence level for “poorly 
scanned pages” open the Settings menu and choose General. Change the Keep 
Images listbox to “Poorly Recognized Pages”. Then open the Tools menu and 
choose Recognition Statistics. From the sub-menu choose “Poorly Recognized 
Pages”. Set the confidence level (typically to 95%). Now any page images that 
are recognized with a confidence level below 95% will be kept. Those page 
images that are at or above 95% will be discarded. To access the poorly 
recognized pages for re-recognition, open the Tools menu and choose 
Recognition Statistics. All page images that were recognized with a confidence 
level below the value that you set (in this case 95%) will be listed in ascending 
order (i.e. the worst first). These images can be opened for re-recognition by 
Tabbing to the list and pressing Enter on them. Before re-recognizing the pages 
make changes to the options in the Recognition dialogue box by opening the 
Settings menu and choosing Recognition. 
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• The number of illegible characters.  These are blobs that Kurzweil 1000 cannot 
recognize as any letter. The greater the number of illegible characters the worse the 
quality of the source document. De-speckling may help in re-recognition. 

• The number of questionable characters. These are the number of letters that 
Kurzweil 1000 guessed at. A high number indicates that you may want to switch to 
FineEngine. 

• The number of touching characters. This is the number of characters that Kurzweil 
1000 separated to make into proper letters.  It is related to the brightness setting of 
the original scan. A high number of touching characters means you should raise the 
brightness setting (found in the Settings menu under Scanning). 

• The number of broken characters. This is the number of separated characters that 
Kurzweil 1000 joined together to make proper letters.  This is also related to the 
brightness setting of the original scan. A high the number of broken characters 
means you should lower the brightness setting. 

• The elapsed time. This is the time it took for all of recognition processes except the 
time it took to physically scan the page. The lower the elapsed time, the better the 
accuracy of the recognition process. 

• The number of automatic corrections. This will tell you how many words were 
automatically corrected by Kurzweil 1000 (see the section “About Automatic 
Corrections”). 

About Automatic Corrections 

Automatic corrections is a permanent list of corrections contained within the Kurzweil 
1000 program. Kurzweil 1000 automatically applies these corrections whenever it 
matches a misrecognized word with one of its corrections when Automatic Corrections is 
enabled. To enable it, open the Setting menu and choose General. By default the 
Automatic Corrections listbox is set to Enabled. If you set it to Disabled you must 
manually Apply Corrections from the Tools menu.   

You can view the extensive (default) list of corrections from the Tools menu by choosing 
Edit Corrections. You can edit this list (e.g. add to it). Since this is a permanent list, all 
corrections (both those that are native and those you add) will be applied to every future 
scan. To add words to the default corrections list: 

1. Open the Tools menu and choose Edit Corrections. 
2. Press the Add Word button, type the exact misspelling and press OK. For 

example you might add “pu!!” which has shown up instead of the “pull”. 
3. The misrecognized word (“pu!!”) is now added and focus has moved to the 

“Replace With” edit field. Type the correct word (“pull”) and press Enter (activates 
the OK button). 

4. Now in future, if Kurzweil 1000 misrecognizes the word “pull” by recognizing it as 
“pu!!” it will automatically correct it. 

You can also create user-defined corrections lists that are separate from the 
default list. To do this see the Editing chapter in the Online Manual. 
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When you use Ranked Spelling in conjunction with the Automatic Corrections 
feature, you can improve the accuracy of the pages you scan (see the section on 
“Ranked Spelling”). 

Ranked Spelling 

Ranked spelling provides statistics on the misspelled words in the entire document. It 
tells the percentage of correctly spelled words and the number of misspelled works. This 
in itself can be useful information about accuracy of the recognition. However, keep in 
mind that a word is only considered misspelled if it is not found in Kurzweil 1000’s 
dictionary. Documents with a lot of jargon, names and/or unconventional words will 
decrease the percentage of words spelled correctly in the Ranked Spelling dialogue box 
without necessarily reflecting on the accuracy of the recognition process. Misspelled 
words are presented according to frequency, i.e. the one with the greatest frequency is 
at the top of the list. Commands for correcting the misspelled words are provided in the 
same dialogue box. The most useful ones, after you have corrected the word (by 
choosing from the list of suggestions or manually typing it in) are, Add to Word List and 
Replace All. Press the Apply button (Alt+P) to add words to the dictionary and re-
generate the Ranked Spelling list. Press Enter to apply changes (to both dictionary and 
the document) and exit the Ranked Spelling dialogue box. 

If you find a word with a high frequency occurrence, you can copy and paste it into the 
Add Word edit field of the Edit Automatic Corrections dialogue box. Type the correct 
spelling and that correction will be applied to all future scanning jobs.   

More About Image Files 

As previously discussed, image files are useful for re-recognition. Changing recognition 
options before re-recognizing can often improve the readability of the final document. 
Kurzweil 1000’s image files have other uses as well. To view the image file for the 
associated page, press Control+W. To close the image file and return to the recognized 
page press Escape or Alt+F4.  “Keep Images” must be enabled for page images to be 
displayed (Settings menu, choose General). The image files used this way are mainly 
useful for users who have some vision. These features are: 

• The ability to magnify text on the fly. Hold down the control key and press the Up 
Arrow and Down Arrow keys to increase and decrease the magnification of the 
image. (Note: The text can also be magnified without going to the image file by 
opening the Settings menu and choosing Display. A fixed magnification level can be 
set here, it cannot be changed on the fly however.) 

 
• The ability to have Kurzweil 1000 read the text from the image file. Kurzweil 1000 will 

read the text in the image file by pressing F5. Depending on the way the image file 
was created during the scan, Kurzweil may block the reading unit in yellow (by 
default) and then track the word in blue (by default). This, combined with 
magnification, can be an effective reading aid for low vision students who benefit 
from large print, tracking and speech feedback. When in the image file the position of 
reading and tracking is tied to the location of the cursor on the recognized page so if 
you switch to the image file half way through the page, it will begin reading from the 
location of the cursor on the recognized page even though the it may not be visible 
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on the screen (i.e. when magnification is set high and the cursor is towards the end 
of the recognized page. Because it is an image file there is no cursor to move and so 
the only way to make sure it reads from the beginning of the image file is to move the 
cursor to the beginning of the recognized page. (Note: Kurzweil 1000 will also track 
the word (in blue by default) as it reads from the recognized page by pressing the 
reading key, F5. It does not, however, highlight the reading unit. Again, word tracking 
combined with magnification can be an effective reading aid for low vision students.) 

 
• Reading from image files can be useful for blind users because Kurzweil 1000 may 

find text contained within, beside or under a graphic that otherwise would not have 
been recognized (because it was associated with the graphic during recognition). 
This may allow users access to information about graphics. 

Using Kurzweil 1000 as a Study Tool 

Kurzweil 1000 has many features that assist the user for research, and organization of 
source material through the creation of bookmarks. It also has features to increase 
reading efficiency through summarizing and browsing. 

About Bookmarks 

Kurzweil 1000 has six levels of bookmarks that can be set. In order to create useful 
bookmarks it is important to understand the structure of the source document. If you 
want to create bookmarks based on headings, for instance, you can: 

• Search for bold text (this is an option in the Find dialogue box).  Press Control+F to 
open the dialogue box and F3 to Find Next occurrence 

• Search for centered text (also an option in the Find dialogue box 
• Use context to determine if it is a heading (e.g. is there a blank like above and/or 

below it) 
• If you want to create bookmarks based on vocabulary or keywords you can search 

by italicized, bolded or underlined text (all available in the Find dialogue box). Since 
documents retain their structure throughout, initial sighted assistance may be a 
useful time saver 

In addition to creating bookmarks so that you can quickly go to a particular place in a 
document, they can also be used to: 

• Create a hierarchy of the headings and sub-headings in order to provide a synopsis 
or snapshot of the contents of the source material. 

• Link the Table of Contents to the chapters. 

• Provide a description of the bookmark. By default the word or sentence associated 
with the bookmark (depending on whether the cursor was on a word in a sentence or 
on a heading) was will be added to the “Description” field within the Bookmarks 
dialogue box. However, selected text may be added or you can Tab to the 
Descriptions field and write your own description. Note that if you edit the 
Descriptions field, the bookmark title will change with it.  The Kurzweil manual gives 

 
Vision Technologies: Access to Literacy - ALT-VI 2003 

Page 113 



Section 6: Independent Production of E-text 

the impression that you can edit the description independently from the title but they 
both change together. 

• Have sounds (chimes) alert you to their presence when re-reading a document. If 
you have re-written the description with your own notes you can jump to these notes 
as you read through the document (see the section “Utility of Boomarks”). 

• Have bookmarks extracted into a summary document (it will be a separate file in rich 
text format .rtf). By doing this you can create a multi-level outline. Since this is a text 
based document, the student can enter important notes or points within the extracted 
bookmark summary. This can then act as an effective study guide. 

Creating Simple Bookmarks (Level 1 only) 

1. Put your cursor on the word that you want to bookmark and press Control+B. A level 
1 bookmark will be created.  

2. Go through and bookmark each important heading, word or phrase that you want to 
be able to quickly jump to. 

3. To jump to your bookmarks, press Control+R and Bookmarks dialogue box will open. 
Tab and Arrow to the bookmark you want to open and press Enter. Kurzweil 1000 
will immediately jump to the bookmark location in the file and begin reading. 

Creating Multi-level Bookmarks (Levels 1 - 6) 

You can make as many bookmarks as you want within the document.  Within the 
Bookmark dialogue box you can set a chime alert to signal the presence of your 
bookmarks (and associated descriptions) when re-reading the document. When the alert 
sounds you can go to the bookmark to retrieve the information that you have inserted in 
the bookmark description. This is one way to access your own notes as you read 
through a document. 

To create multi-level bookmarks: 

1. Place your cursor where you want the bookmark and press Control+B. By default 
it will become a Level 1 bookmark. For this example we will assume the cursor is 
on a main heading. If the chapter headings have already been bookmarked as 
Level 1, Tab to the Level listbox and change it to Level 2. 

 
2. Press Control+B a second time to edit the description (if you want, keeping in 

mind that the bookmark title will change accordingly). 
 

3. Place your cursor on the next bookmark location (within the chapter and press 
Control+B again. For this example we will assume that the cursor is on a sub-
heading.  Tab to the Level listbox and change it to Level 3. 

 
4. Go through the chapter and find all sub-headings and bookmark them as Level 2 

as well.  (Edit descriptions if you want.) 
 

5. You could, as you go through the section, look for important vocabulary words 
and bookmark them as Level 4 (editing the descriptions to include the 
definitions).   
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6. To open the bookmarks after you are done, press Control+R to bring up the 
Bookmarks dialogue box. It present the levels in a typical Windows treeview 
hierarchy where you would expand and collapse the levels using the Left and 
Right Arrow keys. To move up and down in a level by press the Up and Down 
Arrow keys. 

Utility of Bookmarks 

• You can create a summary file of your bookmarks by opening the File menu and 
choosing Summary. You will be asked if you would like to use Bookmarks to create 
the summary. Press “Yes”. You will be asked if you would like to keep Page 
Numbers in the summary. Press “Yes” if this is important. A new Kurzweil 1000 
document will open. The document is in outline form. Each bookmark as a line and is 
prefaced with a number, such as 1 or 1.1 or 1.1.2 depending on the level.  The page 
number for the bookmark follows the description in parenthesis (if you chose to keep 
page numbers). This summary file provides a useful outline of the source document. 
Notes can be added to the Bookmark summary to create a study outline (Note: you 
can have Kurzweil 1000 summarize a document on content as well as bookmarks – 
see the section “Summarizing Information”). 

• Outlines created using bookmarks can be copied and then pasted into a word 
processor (use Paste Special to retain the hierarchical structure) if you would rather 
use your word processor for study guides and outlines. 

• The process of creating bookmarks provides many benefits for the student. The main 
ones are: 

1. On their own, multilevel bookmarks provide an organized synopsis of the source 
document. 

 
2. It provides a starting point for the creation of study outlines and guides. 

 
3. When the chime alert is activated you can access user-created notes as you re-

read a document. These notes would be info that you wrote into the description 
field as you created the bookmarks.  Keep in mind that the bookmark title will 
change when you edit the description.  This is a separate use for bookmarks 
other than allowing quick access to a section or creating study guides based on 
bookmarks, and should not be confused with it (because the bookmark title 
changes). Used this way the bookmarks only use is to access your own notes at 
particular points in the document. 

 
4. The most important benefit is that by creating multilevel bookmarks, students 

become familiar with where information is found in the source document, and 
more importantly with the topics and sub-topics within the source document.  
This is a much more efficient and dynamic method of learning than simply 
reading a document from beginning to end. 

• Power users of Kurzweil 1000 have found that bookmarking is most efficiently used 
when the Table of Contents is used for Level 1, Headings are used for Level 2, Sub-
headings are used for Level 3, and Vocabulary or Keywords are used for Level 4. 
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• New users will benefit from the opportunity to experiment with a gradual introduction 
to multi-level bookmarking. 

Summarizing Information 

As well as making summaries based on bookmarks, you can also have Kurzweil 1000 
create a summary of the recognized document. Press Enter in the Summarize dialogue 
box (rather than Yes to summarize bookmarks) and Kurzweil 1000 will reduce the 
document to about 10% or its original size and attempt to retain the salient points. Each 
point will be on a separate line.  If you wish to add your own information to the summary 
simply type the information into the appropriate place in the summary.  This is very 
useful, but should be reviewed to ensure that it does, in fact, maintain the most important 
points.  

Browsing 

Browsing is a feature of Kurzweil 1000 that allows a student to skim through a document 
by having the program read the first and/or the last line of each paragraph. To Browse a 
document press Shift+F5. Browsing provides a quick overview of the document.  When 
browsing make sure you are at the beginning of the document. 

Conclusion 

Kurzweil 1000 is an OCR program designed to give students access to text based 
information that would not otherwise be available. Beyond that it provides a dynamic 
working environment that facilitates the organization and the efficient retrieval of 
information that goes beyond typical word processors and OCR programs. 
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